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Introduction

Thank you for purchasing Excel 2013 Bible. If you’re just starting with Excel, you’ll be glad 
to know that Excel 2013 is the easiest version ever.

My goal in writing this book is to share with you some of what I know about Excel and, in 
the process, make you more efficient on the job. The book contains everything that you 
need to know to learn the basics of Excel and then move on to more advanced topics at 
your own pace. You’ll find many useful examples and lots of tips and tricks that I’ve 
accumulated over the years.

Is This Book for You?
The Bible series from John Wiley & Sons, Inc., is designed for beginning, intermediate, 
and advanced users. This book covers all the essential components of Excel and provides 
clear and practical examples that you can adapt to your own needs.

In this book, I’ve tried to maintain a good balance between the basics that every Excel 
user needs to know and the more complex topics that will appeal to power users. I’ve 
used Excel for more than 20 years, and I realize that almost everyone still has something 
to learn (including myself). My goal is to make that learning an enjoyable process.

Software Versions
This book was written for Excel 2013 for Windows. Much of the information also applies 
to Excel 2007 and Excel 2010, but if you’re using an older version of Excel, I suggest that 
you put down this book immediately and find a book that’s appropriate for your version 
of Excel. The user interface changes introduced in Excel 2007 are so extensive that this 
book will be very confusing if you use an earlier version.

Also, please note that this book is not applicable to Excel for Mac.

Office 2013 is available in several versions, including a web version, and a version for 
tablets and phones. This book covers only the standard desktop version of Excel 2013.
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Conventions Used in This Book
Take a minute to scan this section to learn some of the typographical and organizational 
conventions that this book uses.

Excel commands
Excel 2013 (like the two previous versions) features a “menu-less” user interface. In place 
of a menu system, Excel uses a context-sensitive Ribbon system. The words along the top 
(such as File, Insert, Page Layout, and so on) are known as tabs. Click a tab, and the 
Ribbon displays the commands for the selected tab. Each command has a name, which is 
(usually) displayed next to or below the icon. The commands are arranged in groups, and 
the group name appears at the bottom of the Ribbon.

The convention I use is to indicate the tab name, followed by the group name, followed by 
the command name. So, the command used to toggle word wrap within a cell is indicated as

Home ➪ Alignment ➪ Wrap Text

You’ll learn more about the Ribbon user interface in Chapter 1.

Filenames, named ranges, and your input
Anything you’re supposed to type using the keyboard appears in bold. Named ranges 
appear in a monofont. Lengthy input usually appears on a separate line. For example, I 
may instruct you to enter a formula such as the following:

=”Part Name: “ &VLOOKUP(PartNumber,PartList,2)

Key names
Names of the keys on your keyboard appear in normal type. When two keys should be 
pressed simultaneously, they’re connected with a plus sign, like this: “Press Ctrl+C to 
copy the selected cells.”

The four “arrow” keys are collectively known as the navigation keys.

Functions
Excel built-in worksheet functions appear in uppercase monofont, like this: “Note the SUM 

formula in cell C20.”

Introduction
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Mouse conventions
You’ll come across some of the following mouse-related terms, all standard fare:

•	 Mouse pointer: The small graphic figure that moves onscreen when you move 
your mouse. The mouse pointer is usually an arrow, but it changes shape when 
you move to certain areas of the screen or when you’re performing certain actions.

•	 Point: Move the mouse so that the mouse pointer is on a specific item: for exam-
ple, “Point to the Save button on the toolbar.”

•	 Click: Press the left mouse button once and release it immediately.

•	 Right-click: Press the right mouse button once and release it immediately. The 
right mouse button is used in Excel to pop up shortcut menus that are appropriate 
for whatever is currently selected.

•	 Double-click: Press the left mouse button twice in rapid succession.

•	 Drag: Press the left mouse button and keep it pressed while you move the mouse. 
Dragging is often used to select a range of cells or to change the size of an object.

Introduction

For Tablet Users

Excel 2013 is also available for mobile devices such as tablets and smartphones. If you happen to be 
using one of these devices, you probably already know the basic touch gestures.

This book doesn’t cover specific touchscreen gestures, but these three guidelines should work most of 
the time:

•	 When you read “click,” you should tap. Quickly touching and releasing your finger on a 
button is the same as clicking it with a mouse.

•	 When you read “double-click,” tap twice. Touching twice in rapid succession is equivalent to 
double-clicking.

•	 When you read “right-click,” press and hold your finger on the item until a menu appears. 
Tap an item on the pop-up menu to execute the command.

Make sure you enable Touch mode from the Quick Access toolbar. Touch mode increases the spacing 
between the Ribbon commands, making it less likely that you’ll touch the wrong command. If the Touch 
mode command is not in your Quick Access toolbar, touch the rightmost control and select Touch 
Mode. This command toggles between normal mode and Touch mode.
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How This Book Is Organized
Notice that the book is divided into six main parts, followed by three appendixes.

•	 Part I: Getting Started with Excel: This part consists of nine chapters that provide 
background about Excel. These chapters are considered required reading for  
Excel newcomers, but even experienced users will probably find some new 
information here.

•	 Part II: Working with Formulas and Functions: The chapters in Part II cover 
everything that you need to know to become proficient with performing calcula-
tions in Excel.

•	 Part III: Creating Charts and Graphics: The chapters in Part III describe how to 
create effective charts. In addition, you’ll find chapters on the conditional format-
ting visualization features, Sparkline graphics, and a chapter with lots of tips on 
integrating graphics into your worksheet.

•	 Part IV: Using Advanced Excel Features: This part consists of eight chapters that 
deal with topics that are sometimes considered advanced. However, many begin-
ning and intermediate users may find this information useful as well.

•	 Part V: Analyzing Data with Excel: Data analysis is the focus of the chapters in 
Part V. Users of all levels will find some of these chapters of interest.

•	 Part VI: Programming Excel with VBA: Part VI is for those who want to custom-
ize Excel for their own use or who are designing workbooks or add-ins that are to 
be used by others. It starts with an introduction to recording macros and VBA pro-
gramming and then provides coverage of UserForms, add-ins, and events.

•	 Part VII: Appendixes: This book has two appendixes that cover Excel worksheet 
functions and Excel shortcut keys.

How to Use This Book
Although you’re certainly free to do so, I didn’t write this book with the intention that you 
would read it cover to cover. Instead, it’s a reference book that you can consult when

•	 You’re stuck while trying to do something.

•	 You need to do something that you’ve never done before.

•	 You have some time on your hands, and you’re interested in learning something 
new about Excel.

The index is comprehensive, and each chapter typically focuses on a single broad topic. If 
you’re just starting out with Excel, I recommend that you read the first few chapters to 
gain a basic understanding of the product and then do some experimenting on your own. 
After you become familiar with Excel’s environment, you can refer to the chapters that 
interest you most. Some readers, however, may prefer to follow the chapters in order.
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Don’t be discouraged if some of the material is over your head. Most users get by just fine 
by using only a small subset of Excel’s total capabilities. In fact, the 80/20 rule applies 
here: 80% of Excel users use only 20% of its features. However, using only 20% of Excel’s 
features still gives you lots of power at your fingertips.

What’s on the Website
This book contains many examples, and you can download the workbooks for those 
examples from the web. The files are arranged in directories that correspond to the 
chapters.

The URL is www.wiley.com/go/excel2013bible.

http://www.wiley.com/go/excel2013bible
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for working with Excel. Here, you’ll see 

how to make use of the basic features that are 
required for every Excel user. If you’ve used 
Excel (or even a different spreadsheet pro-
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3

Introducing Excel

IN THIS CHAPTER

Understanding what Excel is used for

Looking at what’s new in Excel 2013

Learning the parts of an Excel window

Introducing the Ribbon, shortcut menus, dialog boxes, and task panes

Navigating Excel worksheets

Introducing Excel with a step-by-step hands-on session

T
his chapter is an introductory overview of Excel 2013. If you’re already familiar with a previ-
ous version of Excel, reading (or at least skimming) this chapter is still a good idea.

Identifying What Excel Is Good For
Excel, as you probably know, is the world’s most widely used spreadsheet software and part of 
the Microsoft Office suite. Other spreadsheet software is available, but Excel is by far the most 
popular and has been the world standard for many years.

Much of the appeal of Excel is due to the fact that it’s so versatile. Excel’s forte, of course, is  
performing numerical calculations, but Excel is also very useful for non-numeric applications. 
Here are just a few of the uses for Excel:

•	 Number crunching: Create budgets, tabulate expenses, analyze survey results, and  
perform just about any type of financial analysis you can think of.

•	 Creating charts: Create a wide variety of highly customizable charts.

•	 Organizing lists: Use the row-and-column layout to store lists efficiently.

•	 Text manipulation: Clean up and standardize text-based data.

•	 Accessing other data: Import data from a wide variety of sources.
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•	 Creating graphical dashboards: Summarize a large amount of business informa-
tion in a concise format.

•	 Creating graphics and diagrams: Use Shapes and SmartArt to create professional- 
looking diagrams.

•	 Automating complex tasks: Perform a tedious task with a single mouse click with 
Excel’s macro capabilities.

Seeing What’s New in Excel 2013
When a new version of Microsoft Office is released, sometimes Excel gets lots of new fea-
tures and other times it gets very few new features. In the case of Office 2013, Excel got 
quite a few new features.

Here’s a quick summary of what’s new in Excel 2013, relative to Excel 2010:

•	 Cloud storage: Excel is tightly integrated with Microsoft’s SkyDrive web-based 
storage.

•	 Support for other devices: Excel is available for other devices, including touch-
sensitive devices such as Windows RT tablets and Windows phones.

•	 New aesthetics: Excel has a new “flat” look and displays an (optional) graphic in 
the title bar. The default color scheme is white, but you can choose from two 
other color schemes (light gray and dark gray) in the General tab of the Excel 
Options dialog box.

•	 Single document interface: Excel no longer supports the option to display multi-
ple workbooks in a single window. Each workbook has its own top-level Excel 
window and Ribbon.

•	 New types of assistance: Excel provides recommended pivot tables and recom-
mended charts.

•	 Fill Flash: Fill Flash is a new way to extract (by example) relevant data from text 
strings. You can also use this feature to combine data in multiple columns.

•	 Support for Apps for Office: You can download or purchase apps that can be 
embedded in a workbook file.

•	 The Data Model: Create pivot tables from multiple data tables, combined in a 
relational manner.

•	 New Slicer option: The Slicer feature, introduced in Excel 2010 for use with pivot 
tables, has been expanded and now works with tables.
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•	 Timeline filtering: Similar to the Slicer, the Timeline makes it easy to filter data 
by dates.

•	 Quick Analysis: Quick Analysis provides single click access to various data  
analysis tools.

•	 Enhanced chart formatting: Modifying charts is significantly easier.

•	 New worksheet functions: Excel 2013 supports dozens of new worksheet functions.

•	 Backstage: The Backstage screen has been reorganized and is easier to use.

•	 New add-ins: Three new add-ins are included (for Office Professional Plus only): 
PowerPivot, Power View, and Inquire.

Understanding Workbooks and Worksheets
The work you do in Excel is performed in a workbook file. You can have as many work-
books open as you need, and each one appears in its own window. By default, Excel 
workbooks use an .xlsx file extension.

Note

In previous versions of Excel, users could work with multiple workbooks in a single window. That is no longer an option 

in Excel 2013. Every workbook that you open has its own window.

Each workbook contains one or more worksheets, and each worksheet is made up of indi-
vidual cells. Each cell can contain a value, a formula, or text. A worksheet also has an 
invisible draw layer, which holds charts, images, and diagrams. Each worksheet in a 
workbook is accessible by clicking the tab at the bottom of the workbook window. In 
addition, a workbook can store chart sheets; a chart sheet displays a single chart and is 
also accessible by clicking a tab.

Newcomers to Excel are often intimidated by all the different elements that appear within 
Excel’s window. After you become familiar with the various parts, it all starts to make 
sense, and you’ll feel right at home.

Figure 1.1 shows you the more important bits and pieces of Excel. As you look at the fig-
ure, refer to Table 1.1 for a brief explanation of the items shown in the figure.
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FIGURE 1.1

The Excel screen has many useful elements that you will use often.

TABLE 1.1  Parts of the Excel Screen That You Need to Know

Name Description

Active cell  
indicator

This dark outline indicates the currently active cell (one of the 17,179,869,184 
cells on each worksheet).

Collapse the 
Ribbon button

Click this button to temporarily hide the Ribbon. Click it again to make the 
Ribbon remain visible.

Column letters Letters range from A to XFD — one for each of the 16,384 columns in the 
worksheet. You can click a column heading to select an entire column of cells 
or drag a column border to change its width.

File button Click this button to open Backstage view, which contains many options for 
working with your document (including printing) and setting Excel options.
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Name Description

Formula bar When you enter information or formulas into a cell, it appears in this bar.

Help button Click this button to display the Excel Help system window.

Horizontal 
scrollbar

Use this tool to scroll the sheet horizontally.

Macro recorder 
indicator

Click to start recording a VBA macro. The icon changes while your actions 
are being recorded. Click again to stop recording.

Name box This box displays the active cell address or the name of the selected cell, 
range, or object.

New Sheet  
button

Add a new worksheet by clicking the New Sheet button (which is displayed 
after the last sheet tab).

Page View  
buttons

Click these buttons to change the way the worksheet is displayed.

Quick Access 
toolbar

This customizable toolbar holds commonly used commands. The Quick 
Access toolbar is always visible, regardless of which tab is selected.

Ribbon This is the main location for Excel commands. Clicking an item in the tab list 
changes the Ribbon that is displayed.

Ribbon Display 
Options

A drop-down control that offers three options related to displaying the 
Ribbon.

Row numbers Numbers range from 1 to 1,048,576 — one for each row in the worksheet. 
You can click a row number to select an entire row of cells.

Sheet tabs Each of these notebook-like tabs represents a different sheet in the work-
book. A workbook can have any number of sheets, and each sheet has its 
name displayed in a sheet tab.

Sheet tab scroll 
buttons

Use these buttons to scroll the sheet tabs to display tabs that aren’t visible. 
You can also right-click to get a list of sheets.

Status bar This bar displays various messages, as well as the status of the Num Lock, 
Caps Lock, and Scroll Lock keys on your keyboard. It also shows summary 
information about the range of cells selected. Right-click the status bar to 
change the information displayed.

Tab list Use these commands to display a different Ribbon, similar to a menu.

Title bar This displays the name of the program and the name of the current work-
book. It also holds the Quick Access toolbar (on the left) and some control 
buttons that you can use to modify the window (on the right).

Vertical scrollbar Use this to scroll the sheet vertically.

Window Close 
button

Click this button to close the active workbook window.

Window 
Maximize/
Restore button

Click this button to increase the workbook window’s size to fill the entire 
screen. If the window is already maximized, clicking this button “unmaxi-
mizes” Excel’s window so that it no longer fills the entire screen.

Window 
Minimize button

Click this button to minimize the workbook window. The window displays as 
an icon in the Windows taskbar.

Zoom control Use this to zoom your worksheet in and out.
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Moving Around a Worksheet
This section describes various ways to navigate the cells in a worksheet.

Every worksheet consists of rows (numbered 1 through 1,048,576) and columns (labeled 
A through XFD). Column labeling works like this: After column Z comes column AA, 
which is followed by AB, AC, and so on. After column AZ comes BA, BB, and so on. After 
column ZZ is AAA, AAB, and so on.

The intersection of a row and a column is a single cell, and each cell has a unique address 
made up of its column letter and row number. For example, the address of the upper-left 
cell is A1. The address of the cell at the lower right of a worksheet is XFD1048576.

At any given time, one cell is the active cell. The active cell is the cell that accepts key-
board input, and its contents can be edited. You can identify the active cell by its darker 
border, as shown in Figure 1.2. Its address appears in the Name box. Depending on the 
technique that you use to navigate through a workbook, you may or may not change the 
active cell when you navigate.

FIGURE 1.2

The active cell is the cell with the dark border — in this case, cell C8.

Notice that the row and column headings of the active cell appear in a different color to 
make it easier to identify the row and column of the active cell.

Note

Excel 2013 is also available for devices such as tablets and phones. These devices use a touch interface. This book 

assumes the reader has a traditional keyboard and mouse — it doesn’t cover the touch-related commands.

Navigating with your keyboard
Not surprisingly, you can use the standard navigational keys on your keyboard to move 
around a worksheet. These keys work just as you’d expect: The down arrow moves the 
active cell down one row, the right arrow moves it one column to the right, and so on. 
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PgUp and PgDn move the active cell up or down one full window. (The actual number of 
rows moved depends on the number of rows displayed in the window.)

Tip

You can use the keyboard to scroll through the worksheet without changing the active cell by turning on Scroll Lock, 

which is useful if you need to view another area of your worksheet and then quickly return to your original location. Just 

press Scroll Lock and use the navigation keys to scroll through the worksheet. When you want to return to the original 

position (the active cell), press Ctrl+Backspace. Then, press Scroll Lock again to turn it off. When Scroll Lock is turned 

on, Excel displays Scroll Lock in the status bar at the bottom of the window.

The Num Lock key on your keyboard controls how the keys on the numeric keypad 
behave. When Num Lock is on, the keys on your numeric keypad generate numbers. 
Many keyboards have a separate set of navigation (arrow) keys located to the left of the 
numeric keypad. The state of the Num Lock key doesn’t affect these keys.

Table 1.2 summarizes all the worksheet movement keys available in Excel.

TABLE 1.2  Excel Worksheet Movement Keys

Key Action

Up arrow (↑) Moves the active cell up one row

Down arrow (↓) Moves the active cell down one row

Left arrow (←) or Shift+Tab Moves the active cell one column to the left

Right arrow (→) or Tab Moves the active cell one column to the right

PgUp Moves the active cell up one screen

PgDn Moves the active cell down one screen

Alt+PgDn Moves the active cell right one screen

Alt+PgUp Moves the active cell left one screen

Ctrl+Backspace Scrolls the screen so that the active cell is visible

↑* Scrolls the screen up one row (active cell does not change)

↓* Scrolls the screen down one row (active cell does not change)

←* Scrolls the screen left one column (active cell does not change)

→* Scrolls the screen right one column (active cell does not change)

* With Scroll Lock on

Navigating with your mouse
To change the active cell by using the mouse, just click another cell, and it becomes the 
active cell. If the cell that you want to activate isn’t visible in the workbook window, you 
can use the scrollbars to scroll the window in any direction. To scroll one cell, click either 
of the arrows on the scrollbar. To scroll by a complete screen, click either side of the 
scrollbar’s scroll box. You can also drag the scroll box for faster scrolling.
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Tip

If your mouse has a wheel, you can use the mouse wheel to scroll vertically. Also, if you click the wheel and move the 

mouse in any direction, the worksheet scrolls automatically in that direction. The more you move the mouse, the faster 

the scrolling.

Press Ctrl while you use the mouse wheel to zoom the worksheet. If you prefer to use the 
mouse wheel to zoom the worksheet without pressing Ctrl, choose File ➪ Options and 
select the Advanced section. Place a check mark next to the Zoom on Roll with 
IntelliMouse check box.

Using the scrollbars or scrolling with your mouse doesn’t change the active cell. It simply 
scrolls the worksheet. To change the active cell, you must click a new cell after scrolling.

Using the Ribbon
In Office 2007, Microsoft made a dramatic change to the user interface. Traditional menus 
and toolbars were replaced with the Ribbon, a collection of icons at the top of the screen. 
The words above the icons are known as tabs: the Home tab, the Insert tab, and so on. 
Most users find that the Ribbon is easier to use than the old menu system; it can also be 
customized to make it even easier to use (see Chapter 24).

The Ribbon can either be hidden or visible (it’s your choice). To toggle the Ribbon’s visi-
bility, press Ctrl+F1 (or double-click a tab at the top). If the Ribbon is hidden, it tempo-
rarily appears when you click a tab and hides itself when you click in the worksheet. The 
title bar has a control named Ribbon Display Options (next to the Help button). Click the 
control and choose one of three Ribbon options: Auto-hide, Show Tabs, or Show Tabs and 
Commands.

Ribbon tabs
The commands available in the Ribbon vary, depending upon which tab is selected. The 
Ribbon is arranged into groups of related commands. Here’s a quick overview of Excel’s tabs:

•	 Home: You’ll probably spend most of your time with the Home tab selected. This 
tab contains the basic Clipboard commands, formatting commands, style com-
mands, commands to insert and delete rows or columns, plus an assortment of 
worksheet editing commands.

•	 Insert: Select this tab when you need to insert something in a worksheet — a 
table, a diagram, a chart, a symbol, and so on.

•	 Page Layout: This tab contains commands that affect the overall appearance of 
your worksheet, including some settings that deal with printing.

•	 Formulas: Use this tab to insert a formula, name a cell or a range, access the  
formula auditing tools, or control how Excel performs calculations.

•	 Data: Excel’s data-related commands are on this tab, including data validation 
commands.
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•	 Review: This tab contains tools to check spelling, translate words, add comments, 
or protect sheets.

•	 View: The View tab contains commands that control various aspects of how a 
sheet is viewed. Some commands on this tab are also available in the status bar.

•	 Developer: This tab isn’t visible by default. It contains commands that are useful for 
programmers. To display the Developer tab, choose File ➪ Options and then select 
Customize Ribbon. In the Customize the Ribbon section on the right, make sure Main 
Tabs is selected in the drop-down control, and place a check mark next to Developer.

•	 Add-Ins: This tab is visible only if you loaded an older workbook or add-in that 
customizes the menu or toolbars. Because menus and toolbars are no longer avail-
able in Excel 2013, these user interface customizations appear on the Add-Ins tab.

The preceding list contains the standard Ribbon tabs. Excel may display additional Ribbon 
tabs, resulting from add-ins or macros.

Note

Although the File button shares space with the tabs, it’s not actually a tab. Clicking the File button displays a different 

screen (known as Backstage view), where you perform actions with your documents. This screen has commands along 

the left side. To exit the Backstage view, click the back arrow button in the upper-left corner.

The appearance of the commands on the Ribbon varies, depending on the width of the 
Excel window. When the Excel window is too narrow to display everything, the com-
mands adapt; some of them might seem to be missing, but the commands are still avail-
able. Figure 1.3 shows the Home tab of the Ribbon with all controls fully visible. Figure 
1.4 shows the Ribbon when Excel’s window is made more narrow. Notice that some of 
the descriptive text is gone, but the icons remain. Figure 1.5 shows the extreme case when 
the window is made very narrow. Some groups display a single icon; however, if you click 
the icon, all the group commands are available to you.

FIGURE 1.3

The Home tab of the Ribbon.

FIGURE 1.4

The Home tab when Excel’s window is made narrower.
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FIGURE 1.5

The Home tab when Excel’s window is made very narrow.

Contextual tabs
In addition to the standard tabs, Excel also includes contextual tabs. Whenever an object 
(such as a chart, a table, or a SmartArt diagram) is selected, specific tools for working 
with that object are made available in the Ribbon.

Figure 1.6 shows the contextual tabs that appear when a chart is selected. In this case, it 
has two contextual tabs: Design and Format. Notice that the contextual tabs contain a 
description (Chart Tools) in Excel’s title bar. When contextual tabs appear, you can, of 
course, continue to use all the other tabs.

FIGURE 1.6

When you select an object, contextual tabs contain tools for working with that object.
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Types of commands on the Ribbon
When you hover your mouse pointer over a Ribbon command, you’ll see a pop-up box 
that contains the command’s name, as well as a brief description. For the most part, the 
commands in the Ribbon work just as you would expect them to. You’ll find several dif-
ferent styles of commands on the Ribbon:

•	 Simple buttons: Click the button, and it does its thing. An example of a simple 
button is the Increase Font Size button in the Font group of the Home tab. Some 
buttons perform the action immediately; others display a dialog box so that you 
can enter additional information. Button controls may or may not be accompanied 
by a descriptive label.

•	 Toggle buttons: A toggle button is clickable and conveys some type of informa-
tion by displaying two different colors. An example is the Bold button in the Font 
group of the Home tab. If the active cell isn’t bold, the Bold button displays in its 
normal color. If the active cell is already bold, the Bold button displays a different 
background color. If you click the Bold button, it toggles the Bold attribute for the 
selection.

•	 Simple drop-downs: If the Ribbon command has a small down arrow, the com-
mand is a drop-down. Click it, and additional commands appear below it. An 
example of a simple drop-down is the Conditional Formatting command in the 
Styles group of the Home tab. When you click this control, you see several options 
related to conditional formatting.

•	 Split buttons: A split button control combines a one-click button with a drop-
down. If you click the button part, the command is executed. If you click the drop-
down part (a down arrow), you choose from a list of related commands. An 
example of a split button is the Merge & Center command in the Alignment group 
of the Home tab (see Figure 1.7). Clicking the left part of this control merges and 
centers text in the selected cells. If you click the arrow part of the control (on the 
right), you get a list of commands related to merging cells.

FIGURE 1.7

The Merge & Center command is a split button control.
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•	 Check boxes: A check box control turns something on or off. An example is the 
Gridlines control in the Show group of the View tab. When the Gridlines check 
box is checked, the sheet displays gridlines. When the control isn’t checked, the 
gridlines don’t appear.

•	 Spinners: Excel’s Ribbon has only one spinner control: the Scale to Fit group of 
the Page Layout tab. Click the top part of the spinner to increase the value; click 
the bottom part of the spinner to decrease the value.

Some of the Ribbon groups contain a small icon in the bottom-right corner, known as a 
dialog box launcher. For example, if you examine the groups in the Home tab, you find 
dialog box launchers for the Clipboard, Font, Alignment, and Number groups — but not 
the Styles, Cells, and Editing groups. Click the icon, and Excel displays a dialog box. The 
dialog launchers often provide options that aren’t available in the Ribbon.

Accessing the Ribbon by using your keyboard
At first glance, you may think that the Ribbon is completely mouse-centric. After all, the 
commands don’t display the traditional underlined letter to indicate the Alt+keystrokes. 
But in fact, the Ribbon is very keyboard friendly. The trick is to press the Alt key to dis-
play the pop-up keytips. Each Ribbon control has a letter (or series of letters) that you type 
to issue the command.

Tip

You don’t need to hold down the Alt key while you type keytip letters.

Figure 1.8 shows how the Home tab looks after I press the Alt key to display the keytips, 
and then the H key to display the keytips for the Home tab. If you press one of the key-
tips, the screen then displays more keytips. For example, to use the keyboard to align the 
cell contents to the left, press Alt, followed by H (for Home), and then AL (for Align Left).

FIGURE 1.8

Pressing Alt displays the keytips.
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Nobody will memorize all these keys, but if you’re a keyboard fan (like me), it takes just  
a few times before you memorize the keystrokes required for commands that you use  
frequently.

After you press Alt, you can also use the left- and right-arrow keys to scroll through the 
tabs. When you reach the proper tab, press the down arrow to enter the Ribbon. Then use 
left and right arrow keys to scroll through the Ribbon commands. When you reach the 
command you need, press Enter to execute it. This method isn’t as efficient as using the 
keytips, but it’s a quick way to take a look at the commands available.

Tip

Often, you’ll want to repeat a particular command. Excel provides a way to simplify that. For example, if you applied a 

particular style to a cell (by choosing Home ➪ Styles ➪ Cell Styles), you can activate another cell and press Ctrl+Y (or 

F4) to repeat the command.

Using Shortcut Menus
In addition to the Ribbon, Excel features many shortcut menus, which you access by right-
clicking just about anything within Excel. Shortcut menus don’t contain every relevant 
command, just those that are most commonly used for whatever is selected.

As an example, Figure 1.9 shows the shortcut menu that appears when you right-click a 
cell. The shortcut menu appears at the mouse-pointer position, which makes selecting a 
command fast and efficient. The shortcut menu that appears depends on what you’re 
doing at the time. For example, if you’re working with a chart, the shortcut menu contains 
commands that are pertinent to the selected chart element.

The box above the shortcut menu — the Mini toolbar — contains commonly used tools 
from the Home tab. The Mini toolbar was designed to reduce the distance your mouse has 
to travel around the screen. Just right-click, and common formatting tools are within an 
inch of your mouse pointer. The Mini toolbar is particularly useful when a tab other than 
Home is displayed. If you use a tool on the Mini toolbar, the toolbar remains displayed in 
case you want to perform other formatting on the selection.
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FIGURE 1.9

Click the right mouse button to display a shortcut menu of commands you’re most likely  
to use.

Customizing Your Quick Access Toolbar
The Ribbon is fairly efficient, but many users prefer to have some commands available at 
all times, without having to click a tab. The solution is to customize your Quick Access 
toolbar. Typically, the Quick Access toolbar appears on the left side of the title bar, above 
the Ribbon. Alternatively, you can display the Quick Access toolbar below the Ribbon; just 
right-click the Quick Access toolbar and choose Show Quick Access Toolbar below the 
Ribbon.

Displaying the Quick Access toolbar below the Ribbon provides a bit more room for icons, 
but it also means that you see one less row of your worksheet.
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By default, the Quick Access toolbar contains three tools: Save, Undo, and Redo. You can 
customize the Quick Access toolbar by adding other commands that you use often. To add 
a command from the Ribbon to your Quick Access toolbar, right-click the command and 
choose Add to Quick Access Toolbar. If you click the down arrow to the right of the Quick 
Access toolbar, you see a drop-down menu with some additional commands that you 
might want to place in your Quick Access toolbar.

Excel has quite a few commands (mostly obscure ones) that aren’t available on the 
Ribbon. In most cases, the only way to access these commands is to add them to your 
Quick Access toolbar. Right-click the Quick Access toolbar and choose Customize the 
Quick Access Toolbar. You see the Excel Options dialog box, shown in Figure 1.10. This 
section of the Excel Options dialog box is your one-stop shop for Quick Access toolbar 
customization.

Changing Your Mind

You can reverse almost every action in Excel by using the Undo command, located on the Quick Access 
toolbar. Click Undo (or press Ctrl+Z) after issuing a command in error, and it’s as if you never issued the 
command. You can reverse the effects of the past 100 actions that you performed by executing Undo 
more than once.

If you click the arrow on the right side of the Undo button, you see a list of the actions that you can 
reverse. Click an item in that list to undo that action and all the subsequent actions you performed.

Caution

You can’t reverse every action, however. Generally, anything that you do using the File button can’t be undone. For 

example, if you save a file and realize that you’ve overwritten a good copy with a bad one, Undo can’t save the day. 

You’re just out of luck unless you have a backup of the file. Also, changes made by a macro can’t be undone. In 

fact, executing a macro that changes the workbook clears the Undo list.

The Redo button, also on the Quick Access toolbar, performs the opposite of the Undo button:  
Redo reissues commands that have been undone. If nothing has been undone, this command is not 
available.



18

Part I: Getting Started with Excel

FIGURE 1.10

Add new icons to your Quick Access toolbar by using the Quick Access Toolbar section of the 
Excel Options dialog box.

See Chapter 24 for more information about customizing your Quick Access toolbar.

Working with Dialog Boxes
Many Excel commands display a dialog box, which is simply a way of getting more infor-
mation from you. For example, if you choose Review ➪ Changes ➪ Protect Sheet, Excel 
can’t carry out the command until you tell it what parts of the sheet you want to protect. 
Therefore, it displays the Protect Sheet dialog box, shown in Figure 1.11.

FIGURE 1.11

Excel uses a dialog box to get additional information about a command.
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Excel dialog boxes vary in how they work. You’ll find two types of dialog boxes:

•	 Typical dialog box: A modal dialog box takes the focus away from the spread-
sheet. When this type of dialog box is displayed, you can’t do anything in the 
worksheet until you dismiss the dialog box. Clicking OK performs the specified 
actions, and clicking Cancel (or pressing Esc) closes the dialog box without taking 
any action. Most Excel dialog boxes are this type.

•	 Stay-on-top dialog box: A modeless dialog box works in a manner similar to a 
toolbar. When a modeless dialog box is displayed, you can continue working in 
Excel, and the dialog box remains open. Changes made in a modeless dialog box 
take effect immediately. An example of a modeless dialog box is the Find and 
Replace dialog box. You can leave this dialog box open while you continue to use 
your worksheet. A modeless dialog box has a Close button but no OK button.

Most people find working with dialog boxes to be quite straightforward and natural. If 
you’ve used other programs, you’ll feel right at home. You can manipulate the controls 
either with your mouse or directly from the keyboard.

Navigating dialog boxes
Navigating dialog boxes is generally very easy — you simply click the control you want to 
activate.

Although dialog boxes were designed with mouse users in mind, you can also use the key-
board. Every dialog box control has text associated with it, and this text always has one 
underlined letter (a hot key or an accelerator key). You can access the control from the 
keyboard by pressing Alt and then the underlined letter. You can also press Tab to cycle 
through all the controls on a dialog box. Pressing Shift+Tab cycles through the controls in 
reverse order.

Tip

When a control is selected, it appears with a dotted outline. You can use the spacebar to activate a selected control.

Using tabbed dialog boxes
Several Excel dialog boxes are “tabbed” dialog boxes: That is, they include notebook-like 
tabs, each of which is associated with a different panel.

When you select a tab, the dialog box changes to display a new panel containing a new 
set of controls. The Format Cells dialog box, shown in Figure 1.12, is a good example. It 
has six tabs, which makes it functionally equivalent to six different dialog boxes.
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FIGURE 1.12

Use the dialog box tabs to select different functional areas of the dialog box.

Tabbed dialog boxes are quite convenient because you can make several changes in a  
single dialog box. After you make all your setting changes, click OK or press Enter.

Tip

To select a tab by using the keyboard, press Ctrl+PgUp or Ctrl+PgDn, or simply press the first letter of the tab that you 

want to activate.

Using Task Panes
Yet another user interface element is the task pane. Task panes appear automatically in 
response to several commands. For example, to work with a picture, right-click the image 
and choose Format Picture. Excel responds by displaying the Format Picture task pane, 
shown in Figure 1.13. The task pane is similar to a dialog box except that you can keep it 
visible as long as you like.

New Feature

The role of task panes has increased dramatically in Excel 2013. For example, when working with a chart, you can 

access a task pane that has an extensive selection of commands for every element within the chart.

Many of the task panes are very complex. The Format Picture task pane has four icons 
along the top. Clicking an icon changes the command lists displayed below. Click an item 
in a command list and it expands to show the options.
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There’s no OK button in a task pane. When you’re finished using a task pane, click the 
Close button (X) in the upper-right corner. If you prefer to use your keyboard to navigate 
task panes, make sure the task pane is displayed, and then press F6 to activate the task 
pane in keyboard mode. Then you can use the tab key, the arrow keys, the spacebar, and 
other keys that work in dialog boxes.

By default, the task pane is docked on the right side of the Excel window, but you can 
move it anywhere you like by clicking its title bar and dragging. Excel remembers the last 
position, so the next time you use that task pane, it will be right where you left it.

Tip

If you prefer to use your keyboard to work within a task pane, you may find that common dialog box keys such as Tab, 

Space, the arrow keys, and Alt key combinations don’t seem to work. The trick is to press F6. After doing so, you’ll find 

that the task pane works very well using only a keyboard. For example, use the Tab key to activate a section title, and 

then press Enter to expand the section.

FIGURE 1.13

The Format Picture task pane, docked on the right side of the window.

Creating Your First Excel Workbook
This section presents an introductory hands-on session with Excel. If you haven’t used Excel, 
you may want to follow along on your computer to get a feel for how this software works.

In this example, you create a simple monthly sales projection table along with a chart.
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Getting started on your worksheet
Start Excel and make sure that you have an empty workbook displayed. To create a new, 
blank workbook, press Ctrl+N (the shortcut key for File ➪ New ➪ Blank Workbook).

The sales projection will consist of two columns of information. Column A will contain the 
month names, and column B will store the projected sales numbers. You start by entering 
some descriptive titles into the worksheet. Here’s how to begin:

	 1.	 Move the cell pointer to cell A1 (the upper-left cell in the worksheet) by using 
the navigation (arrow) keys. The Name box displays the cell’s address.

	 2.	 Type Month into cell A1 and press Enter. Depending on your setup, either Excel 
moves the cell pointer to a different cell or the pointer remains in cell A1.

	 3.	 Move the cell pointer to B1, type Projected Sales, and press Enter. The text 
extends beyond the cell width, but don’t worry about that for now.

Filling in the month names
In this step, you enter the month names in column A.

	 1.	 Move the cell pointer to A2 and type Jan (an abbreviation for January). At this 
point, you can enter the other month name abbreviations manually or you can let 
Excel do some of the work by taking advantage of the AutoFill feature.

	 2.	 Make sure that cell A2 is selected. Notice that the active cell is displayed with a 
heavy outline. At the bottom-right corner of the outline, you’ll see a small square 
known as the fill handle. Move your mouse pointer over the fill handle, click, and 
drag down until you’ve highlighted from cell A2 down to cell A13.

	 3.	 Release the mouse button, and Excel automatically fills in the month names.

Your worksheet should resemble the one shown in Figure 1.14.

FIGURE 1.14

Your worksheet, after entering the column headings and month names.
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Entering the sales data
Next, you provide the sales projection numbers in column B. Assume that January’s sales 
are projected to be $50,000, and that sales will increase by 3.5 percent in each subsequent 
month.

	 1.	 Move the cell pointer to B2 and type 50000, the projected sales for January. 
You could type a dollar sign and comma to make the number more legible, but 
you do the number formatting a bit later.

	 2.	 To enter a formula to calculate the projected sales for February, move to cell 
B3 and type the following: =B2*103.5%. When you press Enter, the cell dis-
plays 51750. The formula returns the contents of cell B2, multiplied by 103.5%. 
In other words, February sales are projected to be 103.5% of the January sales — 
a 3.5% increase.

	 3.	 The projected sales for subsequent months use a similar formula, but rather 
than retype the formula for each cell in column B, take advantage of the 
AutoFill feature. Make sure that cell B3 is selected. Click the cell’s fill handle, 
drag down to cell B13, and release the mouse button.

At this point, your worksheet should resemble the one shown in Figure 1.15. Keep in 
mind that, except for cell B2, the values in column B are calculated with formulas. To 
demonstrate, try changing the projected sales value for the initial month, January (in cell 
B2). You’ll find that the formulas recalculate and return different values. These formulas 
all depend on the initial value in cell B2, though.

FIGURE 1.15

Your worksheet, after creating the formulas.

Formatting the numbers
The values in the worksheet are difficult to read because they aren’t formatted. In this 
step, you apply a number format to make the numbers easier to read and more consistent 
in appearance:
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	 1.	 Select the numbers by clicking cell B2 and dragging down to cell B13. Don’t 
drag the fill handle this time, though, because you’re selecting cells, not filling a 
range.

	 2.	 Access the Ribbon and choose Home. In the Number group, click the drop-
down Number Format control (it initially displays General), and select 
Currency from the list. The numbers now display with a currency symbol and 
two decimal places. Much better, but the decimal places aren’t necessary for this 
type of projection.

	 3.	 Make sure the range B2:B13 is selected, choose Home ➪ Number, and click the 
Decrease Decimal button. One of the decimal places disappears. Click that but-
ton a second time, and the values are displayed with no decimal places.

Making your worksheet look a bit fancier
At this point, you have a functional worksheet, but it could use some help in the appear-
ance department. Converting this range to an “official” (and attractive) Excel table is a 
snap:

	 1.	 Activate any cell within the range A1:B13.

	 2.	 Choose Insert ➪ Tables ➪ Table. Excel displays the Create Table dialog box to 
make sure that it guessed the range properly.

	 3.	 Click OK to close the Create Table dialog box. Excel applies its default table for-
matting and displays its Table Tools ➪ Design contextual tab.

Your worksheet should look like Figure 1.16.

FIGURE 1.16

Your worksheet, after converting the range to a table.
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If you don’t like the default table style, just select another one from the Table Tools ➪  

Design ➪ Table Styles group. Notice that you can get a preview of different table styles by 
moving your mouse over the Ribbon. When you find one you like, click it, and the style 
will be applied to your table.

Summing the values
The worksheet displays the monthly projected sales, but what about the total projected 
sales for the year? Because this range is a table, it’s simple:

	 1.	 Activate any cell in the table

	 2.	 Choose Table Tools ➪ Design ➪ Table Style Options ➪ Total Row. Excel automat-
ically adds a new row to the bottom of your table, including a formula that calcu-
lates the total of the Projected Sales column.

	 3.	 If you’d prefer to see a different summary formula (for example, average), click 
cell B14 and choose a different summary formula from the drop-down list.

Creating a chart
How about a chart that shows the projected sales for each month?

	 1.	 Activate any cell in the table.

	 2.	 Choose Insert ➪ Charts ➪ Recommended Charts. Excel displays some suggested 
chart type options.

	 3.	 In the Insert Chart dialog box, click the second recommended chart (a column 
chart), and click OK. Excel inserts the chart in the center of the window. To 
move the chart to another location, click its border and drag it.

	 4.	 Click the chart and choose a style using the Chart Tools ➪ Design ➪ Chart 
Styles options.

Figure 1.17 shows the worksheet with a column chart. Your chart may look different, 
depending on the chart style you selected.

On the Web

This workbook is available on this book’s website. The filename is table and chart.xlsx.
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FIGURE 1.17

The table and chart.

Printing your worksheet
Printing your worksheet is very easy (assuming that you have a printer attached and that 
it works properly).

	 1.	 Make sure that the chart isn’t selected. If a chart is selected, the chart will print 
on a page by itself. To deselect the chart, just press Esc or click any cell.

	 2.	 To make use of Excel’s handy Page Layout view, click the Page Layout button 
on the right side of the status bar. Excel displays the worksheet page-by-page so 
that you can easily see how your printed output will look. Figure 1.18 shows the 
worksheet zoomed out to show a complete page. In Page Layout view, you can 
tell immediately whether the chart is too wide to fit on one page. If the chart is 
too wide, click and drag a corner of the chart to resize it or just move the chart 
below the table of numbers.

	 3.	 When you’re ready to print, choose File ➪ Print. At this point, you can change 
some print settings. For example, you can choose to print in landscape rather than 
portrait orientation. Make the change, and you see the result in the preview window.

	 4.	 When you’re satisfied, click the Print button in the upper-left corner. The 
page is printed, and you’re returned to your workbook.

Saving your workbook
Until now, everything that you’ve done has occurred in your computer’s memory. If the 
power should fail, all may be lost — unless Excel’s AutoRecover feature happened to kick 
in. It’s time to save your work to a file on your hard drive.

	 1.	 Click the Save button on the Quick Access toolbar. (This button looks like an 
old-fashioned floppy disk, popular in the previous century.) Because the workbook 
hasn’t been saved yet and still has its default name, Excel responds with a Backstage 
screen that lets you choose the location for the workbook file. The Backstage 
screen lets you save the file to an online location or to your local computer.
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FIGURE 1.18

Viewing the worksheet in Page Layout view.

	 2.	 Select Computer, and then click Browse. Excel displays the Save As dialog box.

	 3.	 In the File Name field, enter a name (such as Monthly Sales Projection), and 
then click Save or press Enter. Excel saves the workbook as a file. The work-
book remains open so that you can work with it some more.

Note

By default, Excel saves a backup copy of your work automatically every ten minutes. To adjust the AutoRecover setting 

(or turn if off), choose File ➪ Options, and click the Save tab of the Excel Options dialog box. However, you should never 

rely on Excel’s AutoRecover feature. Saving your work frequently is a good idea.

If you’ve followed along, you may have realized that creating this workbook was not diffi-
cult. But, of course, you’ve barely scratched the surface of Excel. The remainder of this 
book covers these tasks (and many, many more) in much greater detail.
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IN THIS CHAPTER

Understanding the types of data you can use

Entering text and values into your worksheets

Entering dates and times into your worksheets

Modifying and editing information

Using built-in number formats

T
his chapter describes what you need to know about entering and modifying data in your 
worksheets. As you see, Excel doesn’t treat all data equally. Therefore, you need to learn 
about the various types of data that you can use in an Excel worksheet.

Exploring Data Types
An Excel workbook file can hold any number of worksheets, and each worksheet is made up of 
more than 17 billion cells. A cell can hold any of three basic types of data:

•	 A numeric value

•	 Text

•	 A formula

A worksheet can also hold charts, diagrams, pictures, buttons, and other objects. These objects 
aren’t contained in cells. Instead, they reside on the worksheet’s draw layer, which is an invisi-
ble layer on top of each worksheet.

Chapter 23 discusses some of the items you can place on the draw layer.
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Numeric values
Numeric values represent a quantity of some type: sales amounts, number of employees, 
atomic weights, test scores, and so on. Values also can be dates (such as Feb-26-2013) or 
times (such as 3:24 a.m.).

Excel can display values in many different formats. In the “Applying Number Formatting” section, later in 

this chapter, you see how different format options can affect the display of numeric values.

Text entries
Most worksheets also include text in some of the cells. Text can serve as data (for exam-
ple, a list of employee names), labels for values, headings for columns, or instructions 
about the worksheet. Text is often used to clarify what the values in a worksheet mean or 
where the numbers came from.

Excel’s Numeric Limitations

You may be curious about the types of values that Excel can handle. In other words, how large can a 
number be? And how accurate are large numbers?

Excel’s numbers are precise up to 15 digits. For example, if you enter a large value, such as 
123,456,789,123,456,789 (18 digits), Excel actually stores it with only 15 digits of precision. This 18-digit 
number displays as 123,456,789,123,456,000. This precision may seem quite limiting, but in practice, it 
rarely causes any problems.

One situation in which the 15-digit accuracy can cause a problem is when entering credit card numbers. 
Most credit card numbers are 16 digits, but Excel can handle only 15 digits, so it substitutes a zero for 
the last credit card digit. Even worse, you may not even realize that Excel made the card number 
invalid. The solution? Enter the credit card numbers as text. The easiest way is to preformat the cell as 
Text (choose Home ➪ Number and choose Text from the Number Format drop-down list). Or you can 
precede the credit card number with an apostrophe. Either method prevents Excel from interpreting 
the entry as a number.

Here are some of Excel’s other numeric limits:

•	Largest positive number: 9.9E+307

•	Smallest negative number: –9.9E+307

•	Smallest positive number: 1E–307

•	Largest negative number: –1E–307

These numbers are expressed in scientific notation. For example, the largest positive number is “9.9 
times 10 to the 307th power” — in other words, 99 followed by 306 zeros. Keep in mind, though, that 
this number has only 15 digits of accuracy.
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Text that begins with a number is still considered text. For example, if you type 12 
Employees into a cell, Excel considers the entry to be text rather than a numeric value. 
Consequently, you can’t use this cell for numeric calculations. If you need to indicate that 
the number 12 refers to employees, enter 12 into a cell and then type Employees into the 
cell to the right.

Formulas
Formulas are what make a spreadsheet a spreadsheet. Excel enables you to enter flexible 
formulas that use the values (or even text) in cells to calculate a result. When you enter  
a formula into a cell, the formula’s result appears in the cell. If you change any of the cells 
used by a formula, the formula recalculates and shows the new result.

Formulas can be simple mathematical expressions, or they can use some of the powerful 
functions that are built into Excel. Figure 2.1 shows an Excel worksheet set up to calculate 
a monthly loan payment. The worksheet contains values, text, and formulas. The cells in 
column A contain text. Column B contains four values and two formulas. The formulas 
are in cells B6 and B10. Column D, for reference, shows the actual contents of the cells in 
column B.

FIGURE 2.1

You can use values, text, and formulas to create useful Excel worksheets.

On the Web

This workbook, named loan payment calculator.xlsx, is available on this book’s website.

You can find out much more about formulas in Part II.
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Entering Text and Values into Your Worksheets
To enter a numeric value into a cell, move the cell pointer to the appropriate cell, type the 
value, and then press Enter or one of the navigation keys. The value is displayed in the 
cell and also appears in the Formula bar when the cell is selected. You can include deci-
mal points and currency symbols when entering values, along with plus signs, minus 
signs, and commas (to separate thousands). If you precede a value with a minus sign or 
enclose it in parentheses, Excel considers it to be a negative number.

Entering text into a cell is just as easy as entering a value: Activate the cell, type the text, 
and then press Enter or a navigation key. A cell can contain a maximum of about 32,000 
characters — more than enough to hold a typical chapter in this book. Even though a cell 
can hold a huge number of characters, you’ll find that it’s not possible to actually display 
all these characters.

Tip

If you type an exceptionally long text entry into a cell, the Formula bar may not show all the text. To display more of the 

text in the Formula bar, click the bottom of the Formula bar and drag down to increase the height (see Figure 2.2). Also 

useful is the Ctrl+Shift+U keyboard shortcut. Pressing this key combination toggles the height of the formula bar to 

show either one row, or the previous size.

FIGURE 2.2

The Formula bar, expanded in height to show more information in the cell.
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What happens when you enter text that’s longer than its column’s current width? If the 
cells to the immediate right are blank, Excel displays the text in its entirety, appearing to 
spill the entry into adjacent cells. If an adjacent cell isn’t blank, Excel displays as much of 
the text as possible. (The full text is contained in the cell; it’s just not displayed.) If you 
need to display a long text string in a cell that’s adjacent to a nonblank cell, you have a 
few choices:

•	 Edit your text to make it shorter.

•	 Increase the width of the column (drag the border in the column letter display).

•	 Use a smaller font.

•	 Wrap the text within the cell so that it occupies more than one line. Choose 
Home ➪ Alignment ➪ Wrap Text to toggle wrapping on and off for the selected cell 
or range.

Entering Dates and Times into Your Worksheets
Excel treats dates and times as special types of numeric values. Dates and times are values 
that are formatted so that they appear as dates or times. If you work with dates and times, 
you need to understand Excel’s date and time system.

Entering date values
Excel handles dates by using a serial number system. The earliest date that Excel under-
stands is January 1, 1900. This date has a serial number of 1. January 2, 1900, has a serial 
number of 2, and so on. This system makes it easy to deal with dates in formulas. For 
example, you can enter a formula to calculate the number of days between two dates.

Most of the time, you don’t have to be concerned with Excel’s serial number date system. 
You can simply enter a date in a common date format, and Excel takes care of the details 
behind the scenes. For example, if you need to enter June 1, 2013, you can enter the date 
by typing June 1, 2013 (or use any of several different date formats). Excel interprets your 
entry and stores the value 41426, which is the serial number for that date.

Note

The date examples in this book use the U.S. English system. Your Windows regional settings will affect how Excel inter-

prets a date you’ve entered. For example, depending on your regional date settings, June 1, 2013 may be interpreted as 

text rather than a date. In such a case, you need to enter the date in a format that corresponds to your regional date 

settings — for example, 1 June, 2013.
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For more information about working with dates, see Chapter 12.

Entering time values
When you work with times, you extend Excel’s date serial number system to include deci-
mals. In other words, Excel works with times by using fractional days. For example, the 
date serial number for June 1, 2013, is 41426. Noon on June 1, 2013 (halfway through the 
day), is represented internally as 41426.5 because the time fraction is added to the date 
serial number to get the full date/time serial number.

Again, you normally don’t have to be concerned with these serial numbers or fractional 
serial numbers for times. Just enter the time into a cell in a recognized format. In this 
case, type June 1, 2013 12:00.

See Chapter 12 for more information about working with time values.

Modifying Cell Contents
After you enter a value or text into a cell, you can modify it in several ways:

•	 Delete the cell’s contents.

•	 Replace the cell’s contents with something else.

•	 Edit the cell’s contents.

Note

You can also modify a cell by changing its formatting. However, formatting a cell affects only a cell’s appearance. 

Formatting doesn’t affect the cell’s contents. Later sections in this chapter cover formatting.

Deleting the contents of a cell
To delete the contents of a cell, just click the cell and press the Delete key. To delete more 
than one cell, select all the cells that you want to delete and then press Delete. Pressing 
Delete removes the cell’s contents but doesn’t remove any formatting (such as bold, italic, 
or a different number format) that you may have applied to the cell.

For more control over what gets deleted, you can choose Home ➪ Editing ➪ Clear. This 
command’s drop-down list has five choices:

•	 Clear All: Clears everything from the cell — its contents, its formatting, and its 
cell comment (if it has one).

•	 Clear Formats: Clears only the formatting and leaves the value, text, or formula.

•	 Clear Contents: Clears only the cell’s contents and leaves the formatting.

•	 Clear Comments: Clears the comment (if one exists) attached to the cell.

•	 Clear Hyperlinks: Removes hyperlinks contained in the selected cells. The text 
remains, but the cell no longer functions as a clickable hyperlink.
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Note

Clearing formats doesn’t clear the background colors in a range that has been designated as a table unless you’ve 

replaced the table style background colors manually.

Replacing the contents of a cell
To replace the contents of a cell with something else, just activate the cell and type your 
new entry, which replaces the previous contents. Any formatting applied to the cell 
remains in place and is applied to the new content.

You can also replace cell contents by dragging and dropping or by pasting data from the 
Clipboard. In both cases, the cell formatting will be replaced by the format of the new 
data. To avoid pasting formatting, choose Home ➪ Clipboard ➪ Paste ➪ Values (V), or Hom
e ➪ Clipboard ➪ Paste ➪ Formulas (F).

Editing the contents of a cell
If the cell contains only a few characters, replacing its contents by typing new data usually 
is easiest. However, if the cell contains lengthy text or a complex formula and you need to 
make only a slight modification, you probably want to edit the cell rather than re-enter 
information.

When you want to edit the contents of a cell, you can use one of the following ways to 
enter cell-edit mode:

•	 Double-click the cell to edit the cell contents directly in the cell.

•	 Select the cell and press F2 to edit the cell contents directly in the cell.

•	 Select the cell that you want to edit and then click inside the Formula bar to 
edit the cell contents in the Formula bar.

You can use whichever method you prefer. Some people find editing directly in the cell 
easier; others prefer to use the Formula bar to edit a cell.

Note

The Advanced tab of the Excel Options dialog box contains a section called Editing Options. These settings affect how 

editing works. (To access this dialog box, choose File ➪ Options.) If the Allow Editing Directly in Cells option isn’t 

enabled, you can’t edit a cell by double-clicking. In addition, pressing F2 allows you to edit the cell in the Formula bar 

(not directly in the cell).

All these methods cause Excel to go into edit mode. (The word Edit appears at the left side 
of the status bar at the bottom of the screen.) When Excel is in edit mode, the Formula bar 
enables two icons: Cancel (the X) and Enter (the check mark). Figure 2.3 shows these two 
icons. Clicking the Cancel icon cancels editing without changing the cell’s contents. 
(Pressing Esc has the same effect.) Clicking the Enter icon completes the editing and 
enters the modified contents into the cell. (Pressing Enter has the same effect.)
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FIGURE 2.3

While editing a cell, the Formula bar enables two new icons: Cancel (X) and Enter (check mark).

When you begin editing a cell, the insertion point appears as a vertical bar, and you can 
perform the following tasks:

•	 Add new characters at the location of the insertion point. Move the insertion 
point by

■	 Using the navigation keys to move within the cell

■	 Pressing Home to move the insertion point to the beginning of the cell

■	 Pressing End to move the insertion point to the end of the cell

•	 Select multiple characters. Press Shift while you use the navigation keys.

•	 Select characters while you’re editing a cell. Use the mouse. Just click and drag 
the mouse pointer over the characters that you want to select.

Learning some handy data-entry techniques
You can simplify the process of entering information into your Excel worksheets and make 
your work go quite a bit faster by using a number of useful tricks, described in the follow-
ing sections.

Automatically moving the cell pointer after entering data

By default, Excel automatically moves the cell pointer to the next cell down when you 
press the Enter key after entering data into a cell. To change this setting, choose 
File ➪ Options and click the Advanced tab (see Figure 2.4). The check box that controls 
this behavior is labeled After Pressing Enter, Move Selection. If you enable this option, 
you can choose the direction in which the cell pointer moves (down, left, up, or right).

Your choice is completely a matter of personal preference. I prefer to keep this option 
turned off. When entering data, I use the navigation keys rather than the Enter key (see 
the next section).
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FIGURE 2.4

You can use the Advanced tab in Excel Options to select a number of helpful input option settings.

Using navigation keys instead of pressing Enter

Instead of pressing the Enter key when you’re finished making a cell entry, you also can 
use any of the navigation keys to complete the entry. Not surprisingly, these navigation 
keys send you in the direction that you indicate. For example, if you’re entering data in a 
row, press the right-arrow (→) key rather than Enter. The other arrow keys work as 
expected, and you can even use PgUp and PgDn.

Selecting a range of input cells before entering data

When a range of cells is selected, Excel automatically moves the cell pointer to the next 
cell in the range when you press Enter. If the selection consists of multiple rows, Excel 
moves down the column; when it reaches the end of the selection in the column, it moves 
to the first selected cell in the next column.

To skip a cell, just press Enter without entering anything. To go backward, press 
Shift+Enter. If you prefer to enter the data by rows rather than by columns, press Tab 
rather than Enter. Excel continues to cycle through the selected range until you select a 
cell outside of the range.
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Using Ctrl+Enter to place information into multiple cells simultaneously

If you need to enter the same data into multiple cells, Excel offers a handy shortcut. Select 
all the cells that you want to contain the data, enter the value, text, or formula, and then 
press Ctrl+Enter. The same information is inserted into each cell in the selection.

Entering decimal points automatically

If you need to enter lots of numbers with a fixed number of decimal places, Excel has a 
useful tool that works like some old adding machines. Access the Excel Options dialog box 
and click the Advanced tab. Select the Automatically Insert a Decimal Point check box and 
make sure that the Places box is set for the correct number of decimal places for the data 
you need to enter.

When this option is set, Excel supplies the decimal points for you automatically. For 
example, if you specify two decimal places, entering 12345 into a cell is interpreted as 
123.45. To restore things to normal, just clear the Automatically Insert a Decimal Point 
check box in the Excel Options dialog box. Changing this setting doesn’t affect any values 
that you already entered.

Caution

The fixed decimal places option is a global setting and applies to all workbooks (not just the active workbook). If you 

forget that this option is turned on, you can easily end up entering incorrect values — or cause some major confusion if 

someone else uses your computer.

Using AutoFill to enter a series of values

The Excel AutoFill feature makes inserting a series of values or text items in a range of 
cells easy. It uses the AutoFill handle (the small box at the lower right of the active cell). 
You can drag the AutoFill handle to copy the cell or automatically complete a series.

Figure 2.5 shows an example. I entered 1 into cell A1 and 3 into cell A2. Then I selected 
both cells and dragged down the fill handle to create a linear series of odd numbers. The 
figure also shows an icon that, when clicked, displays some additional AutoFill options.

Tip

If you drag the AutoFill handle while you press and hold the right mouse button, Excel displays a shortcut menu with 

additional fill options.

Using AutoComplete to automate data entry

The Excel AutoComplete feature makes entering the same text into multiple cells easy. 
With AutoComplete, you type the first few letters of a text entry into a cell, and Excel 
automatically completes the entry based on other entries that you already made in the col-
umn. Besides reducing typing, this feature also ensures that your entries are spelled cor-
rectly and are consistent.
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FIGURE 2.5

This series was created by using AutoFill.

Here’s how it works: Suppose that you’re entering product information in a column. One 
of your products is named Widgets. The first time that you enter Widgets into a cell, Excel 
remembers it. Later, when you start typing Widgets in that same column, Excel recog-
nizes it by the first few letters and finishes typing it for you. Just press Enter, and you’re 
done. To override the suggestion, just keep typing.

AutoComplete also changes the case of letters for you automatically. If you start entering 
widgets (with a lowercase w) in the second entry, Excel makes the w uppercase to be con-
sistent with the previous entry in the column.

Tip

You also can access a mouse-oriented version of AutoComplete by right-clicking the cell and choosing Pick from Drop-

Down List from the shortcut menu. Excel then displays a drop-down box that has all the text entries in the current col-

umn, and you just click the one that you want.

Keep in mind that AutoComplete works only within a contiguous column of cells. If you 
have a blank row, for example, AutoComplete identifies only the cell contents below the 
blank row.

If you find the AutoComplete feature distracting, you can turn it off by using the Advanced 
tab of the Excel Options dialog box. Remove the check mark from the check box labeled 
Enable AutoComplete for Cell Values.
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Forcing text to appear on a new line within a cell

If you have lengthy text in a cell, you can force Excel to display it in multiple lines within 
the cell: Press Alt+Enter to start a new line in a cell.

When you add a line break, Excel automatically changes the cell’s format to Wrap Text. 
But unlike normal text wrap, your manual line break forces Excel to break the text at a 
specific place within the text, which gives you more precise control over the appearance of 
the text than if you rely on automatic text wrapping.

Tip

To remove a manual line break, edit the cell and press Delete when the insertion point is located at the end of the line 

that contains the manual line break. You won’t see any symbol to indicate the position of the manual line break, but the 

text that follows it will move up when the line break is deleted.

Using AutoCorrect for shorthand data entry

You can use the AutoCorrect feature to create shortcuts for commonly used words or 
phrases. For example, if you work for a company named Consolidated Data Processing 
Corporation, you can create an AutoCorrect entry for an abbreviation, such as cdp. Then, 
whenever you type cdp, Excel automatically changes it to Consolidated Data Processing 
Corporation.

Excel includes quite a few built-in AutoCorrect terms (mostly to correct common misspell-
ings), and you can add your own. To set up your custom AutoCorrect entries, access the 
Excel Options dialog box (choose File ➪ Options) and click the Proofing tab. Then click the 
AutoCorrect Options button to display the AutoCorrect dialog box. In the dialog box, click 
the AutoCorrect tab, check the option labeled Replace Text as You Type, and then enter 
your custom entries. (Figure 2.6 shows an example.) You can set up as many custom 
entries as you like. Just be careful not to use an abbreviation that might appear normally 
in your text.

Tip

Excel shares your AutoCorrect list with other Microsoft Office applications. For example, any AutoCorrect entries you  

created in Word also work in Excel.

Entering numbers with fractions

To enter a fractional value into a cell, leave a space between the whole number and the 
fraction. For example, to enter 67⁄8, enter 6 7/8 and then press Enter. When you select the 
cell, 6.875 appears in the Formula bar, and the cell entry appears as a fraction. If you have 
a fraction only (for example, 1⁄8), you must enter a zero first, like this — 0 1/8 — or Excel 
will likely assume that you’re entering a date. When you select the cell and look at the 
Formula bar, you see 0.125. In the cell, you see 1⁄8.



41

Chapter 2: Entering and Editing Worksheet Data

 2

FIGURE 2.6

AutoCorrect allows you to create shorthand abbreviations for text you enter often.

Using a form for data entry

Many people use Excel to manage lists in which the information is arranged in rows. Excel 
offers a simple way to work with this type of data through the use of a data entry form 
that Excel can create automatically. This data form works with either a normal range of 
data, or with a range that has been designated as a table (choose Insert ➪ Tables ➪ Table). 
Figure 2.7 shows an example.

FIGURE 2.7

Excel’s built-in data form can simplify many data-entry tasks.
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Unfortunately, the command to access the data form is not on the Ribbon. To use the data 
form, you must add it to your Quick Access toolbar or add it to the Ribbon. The following 
instructions describe how to add this command to your Quick Access toolbar:

	 1.	 Right-click the Quick Access toolbar and choose Customize Quick Access 
Toolbar. The Quick Access Toolbar panel of the Excel Options dialog box 
appears.

	 2.	 In the Choose Commands From drop-down list, choose Commands Not in the 
Ribbon.

	 3.	 In the list box on the left, select Form.

	 4.	 Click the Add button to add the selected command to your Quick Access  
toolbar.

	 5.	 Click OK to close the Excel Options dialog box.

After performing these steps, a new icon appears on your Quick Access toolbar.

To use a data entry form, follow these steps:

	 1.	 Arrange your data so that Excel can recognize it as a table by entering head-
ings for the columns in the first row of your data entry range.

	 2.	 Select any cell in the table and click the Form button on your Quick Access 
toolbar. Excel displays a dialog box customized to your data (refer to Figure 2.7).

	 3.	 Fill in the information. Press Tab to move between the text boxes. If a cell con-
tains a formula, the formula result appears as text (not as an edit box). In other 
words, you can’t modify formulas using the data entry form.

	 4.	 When you complete the data form, click the New button. Excel enters the data 
into a row in the worksheet and clears the dialog box for the next row of data.

You can also use the form to edit existing data.

Entering the current date or time into a cell

If you need to date-stamp or time-stamp your worksheet, Excel provides two shortcut keys 
that do this task for you:

•	 Current date: Ctrl+; (semicolon)

•	 Current time: Ctrl+Shift+; (semicolon)

The date and time are from the system time in your computer. If the date or time isn’t cor-
rect in Excel, use the Windows Control Panel to make the adjustment.
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Note

When you use either of these shortcuts to enter a date or time into your worksheet, Excel enters a static value into the 

worksheet. In other words, the date or time entered doesn’t change when the worksheet is recalculated. In most cases, 

this setup is probably what you want, but you should be aware of this limitation. If you want the date or time display to 

update, use one of these formulas:

=TODAY()

=NOW()

Applying Number Formatting
Number formatting refers to the process of changing the appearance of values contained in 
cells. Excel provides a wide variety of number formatting options. In the following sec-
tions, you see how to use many of Excel’s formatting options to quickly improve the 
appearance of your worksheets.

Tip

The formatting that you apply works with the selected cell or cells. Therefore, you need to select the cell (or range of 

cells) before applying the formatting. Also remember that changing the number format does not affect the underlying 

value. Number formatting affects only the appearance.

Values that you enter into cells normally are unformatted. In other words, they simply 
consist of a string of numerals. Typically, you want to format the numbers so that they’re 
easier to read or are more consistent in terms of the number of decimal places shown.

Figure 2.8 shows a worksheet that has two columns of values. The first column consists of 
unformatted values. The cells in the second column are formatted to make the values eas-
ier to read. The third column describes the type of formatting applied.

On the Web

This workbook is available on this book’s website. The file is named number formatting.xlsx.

Tip

If you move the cell pointer to a cell that has a formatted value, the Formula bar displays the value in its unformatted 

state because the formatting affects only how the value appears in the cell — not the actual value contained in the cell. 

There are a few exceptions, however. When you enter a date or a time, Excel always displays the value as a date or a 

time, even though it’s stored internally as a value. Also, values that use the Percentage format display with a percent 

sign in the Formula bar.
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FIGURE 2.8

Use numeric formatting to make it easier to understand what the values in the worksheet  
represent.

Using automatic number formatting
Excel is smart enough to perform some formatting for you automatically. For example, if 
you enter 12.2% into a cell, Excel knows that you want to use a percentage format and 
applies it for you automatically. If you use commas to separate thousands (such as 
123,456), Excel applies comma formatting for you. And if you precede your value with a 
dollar sign, the cell is formatted for currency (assuming that the dollar sign is your system 
currency symbol).

Tip

A handy default feature in Excel makes entering percentage values into cells easier. If a cell is formatted to display as a 

percent, you can simply enter a normal value (for example, 12.5 for 12.5%). To enter values less than 1%, precede the 

value with a zero (for example, 0.52 for 0.52%). If this automatic percent entry feature isn’t working (or if you prefer to 

enter the actual value for percents), access the Excel Options dialog box and click the Advanced tab. In the Editing 

Options section, locate the Enable Automatic Percent Entry check box and add or remove the check mark.

Formatting numbers by using the Ribbon
The Home ➪ Number group in the Ribbon contains controls that let you quickly apply 
common number formats (see Figure 2.9).

The Number Format drop-down list contains 11 common number formats. Additional 
options include an Accounting Number Format drop-down list (to select a currency format), 
a Percent Style button, and a Comma Style button. The group also contains a button to 
increase the number of decimal places, and another to decrease the number of decimal 
places.
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FIGURE 2.9

You can find number formatting commands in the Number group of the Home tab.

When you select one of these controls, the active cell takes on the specified number for-
mat. You also can select a range of cells (or even an entire row or column) before clicking 
these buttons. If you select more than one cell, Excel applies the number format to all the 
selected cells.

Using shortcut keys to format numbers
Another way to apply number formatting is to use shortcut keys. Table 2.1 summarizes 
the shortcut-key combinations that you can use to apply common number formatting to 
the selected cells or range. Notice that these Ctrl+Shift characters are all located together, 
in the upper left of your keyboard.

TABLE 2.1  Number Formatting Keyboard Shortcuts

Key Combination Formatting Applied

Ctrl+Shift+~ General number format (that is, unformatted values)

Ctrl+Shift+$ Currency format with two decimal places (negative numbers appear in 
parentheses)

Ctrl+Shift+% Percentage format, with no decimal places

Ctrl+Shift+^ Scientific notation number format, with two decimal places

Ctrl+Shift+# Date format with the day, month, and year

Ctrl+Shift+@ Time format with the hour, minute, and AM or PM

Ctrl+Shift+! Two decimal places, thousands separator, and a hyphen for negative values

Formatting numbers using the Format Cells dialog box
In most cases, the number formats that are accessible from the Number group on the Home 
tab are just fine. Sometimes, however, you want more control over how your values 
appear. Excel offers a great deal of control over number formats through the use of the 
Format Cells dialog box, shown in Figure 2.10. For formatting numbers, you need to use 
the Number tab.
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FIGURE 2.10

When you need more control over number formats, use the Number tab of the Format Cells 
dialog box.

You can bring up the Format Cells dialog box in several ways. Start by selecting the cell or 
cells that you want to format and then do one of the following:

•	 Choose Home ➪ Number and click the small dialog box launcher icon (in the 
lower-right corner of the Number group).

•	 Choose Home ➪ Number, click the Number Format drop-down list, and choose 
More Number Formats from the drop-down list.

•	 Right-click the cell and choose Format Cells from the shortcut menu.

•	 Press Ctrl+1.

The Number tab of the Format Cells dialog box displays 12 categories of number formats. 
When you select a category from the list box, the right side of the tab changes to display 
options appropriate to that category.

The Number category has three options that you can control: the number of decimal 
places displayed, whether to use a thousands separator, and how you want negative num-
bers displayed. Notice that the Negative Numbers list box has four choices (two of which 
display negative values in red), and the choices change depending on the number of deci-
mal places and whether you choose to separate thousands.

The top of the tab displays a sample of how the active cell will appear with the selected 
number format (visible only if a cell with a value is selected). After you make your 
choices, click OK to apply the number format to all the selected cells.
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Chapter 10 discusses ROUND and other built-in functions.

The following are the number format categories, along with some general comments:

•	 General: The default format; it displays numbers as integers, as decimals, or in 
scientific notation if the value is too wide to fit in the cell.

•	 Number: Enables you to specify the number of decimal places, whether to use a 
comma to separate thousands, and how to display negative numbers (with a 
minus sign, in red, in parentheses, or in red and in parentheses).

•	 Currency: Enables you to specify the number of decimal places, choose a currency 
symbol, and how to display negative numbers (with a minus sign, in red, in 
parentheses, or in red and in parentheses). This format always uses a comma to 
separate thousands.

•	 Accounting: Differs from the Currency format in that the currency symbols always 
align vertically.

•	 Date: Enables you to choose from several different date formats.

•	 Time: Enables you to choose from several different time formats.

•	 Percentage: Enables you to choose the number of decimal places and always dis-
plays a percent sign.

•	 Fraction: Enables you to choose from among nine fraction formats.

When Numbers Appear to Add Incorrectly

Applying a number format to a cell doesn’t change the value — it only changes how the value appears 
in the worksheet. For example, if a cell contains 0.874543, you may format it to appear as 87%. If that 
cell is used in a formula, the formula uses the full value (0.874543), not the displayed value (87%).

In some situations, formatting may cause Excel to display calculation results that appear incorrect, such 
as when totaling numbers with decimal places. For example, if values are formatted to display two 
decimal places, you may not see the actual numbers used in the calculations. But because Excel uses 
the full precision of the values in its formula, the sum of the two values may appear to be incorrect.

Several solutions to this problem are available. You can format the cells to display more decimal places. 
You can use the ROUND function on individual numbers and specify the number of decimal places Excel 
should round to. Or you can instruct Excel to change the worksheet values to match their displayed 
format. To do so, access the Excel Options dialog box and click the Advanced tab. Check the Set 
Precision as Displayed check box (located in the When Calculating This Workbook section).

Caution

Selecting the Precision as Displayed option changes the numbers in your worksheets to permanently match their 

appearance onscreen. This setting applies to all sheets in the active workbook. Most of the time, this option is not 

what you want. Make sure that you understand the consequences of using the Set Precision as Displayed option.
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•	 Scientific: Displays numbers in exponential notation (with an E): 2.00E+05 = 
200,000; 2.05E+05 = 205,000. You can choose the number of decimal places to 
display to the left of E. The second example can be read as “2.05 times 10 to the 
fifth.”

•	 Text: When applied to a value, causes Excel to treat the value as text (even if it 
looks like a number). This feature is useful for such items as part numbers and 
credit card numbers.

•	 Special: Contains additional number formats. In the U.S. version of Excel, the 
additional number formats are Zip Code, Zip Code +4, Phone Number, and Social 
Security Number.

•	 Custom: Enables you to define custom number formats that aren’t included in any 
other category.

Tip

If a cell displays a series of hash marks (such as #########), it usually means that the column isn’t wide enough to 

display the value in the number format that you selected. Either make the column wider or change the number format.

Adding your own custom number formats
Sometimes you may want to display numerical values in a format that isn’t included in 
any of the other categories. If so, the answer is to create your own custom format.

Excel provides you with a great deal of flexibility in creating number formats — so much so that I’ve 

devoted an entire chapter (Chapter 25) to this topic.


